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I. Introduction  
 
Before You Start…  

• These instructions cover a NEW installation of Oracle 10g and assumes that no previous version of 
Oracle has been installed on the PC.  If your PC has an existing version of Oracle, please contact the 
CARLI Office before you begin this installation process. 
 

• A CARLI Oracle Account (username and password) is required before installation and to run MS Access 
reports or Strawn Utilities.  Your library’s Director or I-Share Liaison should request an Oracle 
username/password for each individual staff member by filing a Work Request Online (WRO). For more 
information, see http://www.carli.illinois.edu/products-services/i-share/reports/starting-access-reports . 

 
• If you run into problems at any point please stop and seek assistance from CARLI Support.  

 
• The Oracle 10g client replaces any pre-existing Oracle clients on the PC. 

 
• CARLI’s servers require that the Oracle 10g client on the PC use encryption. If your campus uses 

Oracle clients to connect to other local Oracle databases, the encryption set up required to connect to 
CARLI servers may impede connections to local Oracle databases.  Before proceeding with this 
installation, consult your local IT staff and CARLI, if necessary. 

 
• Make sure that the Windows login used during this installation has Local Administrator rights before 

you begin. Consult your local IT Department if you are unsure or do not have Local Administrator rights.  
 

• Once the uninstall process has started, do not leave it unattended or start working on a different 
application until you have completed the process. Doing either may cause the application to freeze and 
require a reboot to resolve. Rebooting at the wrong time could greatly complicate the uninstall process.  

 
• Shutdown all other applications. Temporarily disable any PC firewall & virus software during installation.  

 
• If you are running Norton AntiVirus 2006 or later, linking in Section VI will not work by default. Read 

Microsoft's Knowledge Base Article 329820 (http://support.microsoft.com/kb/329820) for help. 
Otherwise, consult with your IT department.  

 
• The Ex Libris Automation Tool is designed and tested for use with Voyager.  If you have non-Voyager 

applications that use Oracle/ODBC check with your IT Department before proceeding, as this tool will 
uninstall existing Oracle applications.  
 

• Many of the screenshots provided in this document were taken using Windows 7 and Microsoft Access 
2007 and 2013. If you are running a different versions of Windows or Microsoft Access, your screen 
may appear slightly different.  

 
• Supported software versions: Windows Vista, Windows 7 (32-bit preferred, 64-bit acceptable); Microsoft 

Access 2000 and up (32-bit version only). See “Known Issues for 64-bit Windows and Office” below for 
more details on supported software. 

 
• If persistent network issues prevent you from downloading the zip file, you can request a physical CD 

from CARLI. There may be a delay in preparing and shipping the CD.   
 
Why all the reboots?  
For a cleaner and faster uninstall (and install) process. Rebooting the PC…  

• …just before critical work helps minimize services competing for system resources.  
• …then shutting down all other programs minimizes program fragments and memory leaks.  
• …after making registry changes ensures that the link between PC files and previous registry data no 

longer exists.  

http://www.carli.illinois.edu/products-services/i-share/reports/starting-access-reports
http://support.microsoft.com/kb/329820
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II. Downloading the Oracle 10g Client Package  
 
Before You Start  
 
The .zip download requires 500MB free space.  The installation requires an additional 500MB free space. In 

addition to the .zip file there are two other files to download. 
 
Instructions  
 

1. Download the package and the two additional files 
 

a. Go to the CARLI website:  
 http://www.carli.illinois.edu/products-services/i-share/execute#10g  

 
b. Click on the link to download the file appropriate for the PC’s Operating System:  
 

Version 10203 for Windows Vista™ or Windows 7™.   
 

c. Save the .zip file to your PC.  
 

i. Be sure to remember where you save the file. The Desktop may be a good choice for 
ease of locating the file later. 

 
ii. Do not select Open at this time.  
 

d. Wait for the download to complete.  
 

i. This file is very large (over 400MB); depending on the speed of your connection, it may 
take a long time to complete the download.  

 
e. Right click and “Save As” to download the two additional files from the CARLI website to your PC: 
 

i. ExLibrisOracle.rsp 
 
ii. sqlnet.ora 
 

f. Save the two files to your PC. 
 

i. Be sure to remember where you save the files. The Desktop may be a good choice for 
ease of locating the files later. 

 
ii. Do not select to Open them.  

 
 

2. Extract the package  
 

a. Create a new folder on your PC that will be used when you will extract the .zip package in the 
next step.  CARLI recommends naming the folder C:\Oracle10g. 

 
Warning: DO NOT create this new folder within an existing \oracle\ folder! 

 
b.  Extract the downloaded file to the new folder you just created, for example: C:\Oracle10g.  

 NOTE: Because the file is so large, the extraction process may take quite a long time. 
 

i. The WinZip software is commonly used for this process.  Windows 7 and above also 

http://www.carli.illinois.edu/products-services/i-share/execute#10g
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has a built-in extraction program. 
 
ii. Check with your IT department if you are unsure which program to use or how to 

extract a .zip file.  
 
iii. Ensure that you preserve the folder names when you extract the file to the new 

directory. (In WinZip you check the Use folder names option.) 
 
iv. If you use the Window built-in extractor, be sure to type the name of the folder you 

created. Accepting the default folder name may hinder later installation steps. 
 
 

3. Install the ExLibrisOracle.rsp file that you downloaded from the CARLI website to your PC.   
 
a. Locate, but do not open, the ExLibrisOracle.rsp file that you downloaded from the CARLI 

website to your PC. 
 
b. Navigate to the new folder that you created to extract the .zip file into.  The example given above 

is C:\Oracle10g.   
 
c. Open the following directory: 
 

 
For Windows Vista™or Windows 7™ C:\Oracle10g\10203_client_vista-win7\response\ 

 
d. Copy and paste (or move) the ExLibrisOracle.rsp file that you downloaded from the CARLI 

website into the \response\ subfolder to replace the existing file of the same name. 
 
e. When prompted to replace the existing file, say Yes. 

 
The Oracle 10g ODBC package is ready to install!  
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III. Installing Oracle 10g  
 
Before You Start  
 
Be sure that you have the Oracle 10g installation for your version of Windows, supplied by CARLI from Ex 
Libris. See section II. Downloading the Oracle 10g Client Package for more information.  
 
Be sure that the Oracle installation files are in the folder you created. E.g., C:\Oracle10g\10203_client_vista-
win7 (Not in C:\Oracle10g\10203_client_vista-win7\10203_client_vista-win7). 
 
Be sure that the ExLibrisOracle.rsp file from the CARLI website is in the response subfolder where the 
installation files are. E.g., C:\Oracle10g\10203_client_vista-win7\response 
 
Be sure that you log on to the computer with administrative rights to install software and update the computer, 
and that you run the command prompt “As Administrator.” 
 
Installing Oracle 10g for Windows Vista ONLY 
(for Windows 7, see page 6) 
 

1. Restart your computer  
 

a. Login to the PC as an Administrator. 
 
b. Ensure there are no open programs. Temporarily disable any PC firewall or virus software. 
 

2. Start the Ex Libris Automation Tool 
 

a. The following instructions assume you extracted the zip file to C:\Oracle10g  
 
b. Open the appropriate package directory folder: 
 

 
For Windows Vista™ the folder is C:\Oracle10g\10203_client_vista-win7\  
 

c. Double-click on the BEAT.bat icon/file to run it.  
 
d. If you receive a notification that the “Publisher could not be verified. Are you sure you want to run 

this software?” Click Run. 
e. The following screen should appear:  

 
 
 
3. Install Oracle 10g  
 

a. Select option 3. Install Oracle 10i Client by pressing 3 (this is a typo in the program, it means 
10g), then press Enter. 
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b. When prompted answer Y to install the Oracle 10g client  
 
c. Do not attempt to change the window focus during the installation process!  Installation of 

Oracle 10g may take a few minutes.  Various messages will scroll through on the screen.  Do 
not press any keys or interrupt the installation process. 

 
d. Wait for a message indicating that the installation has completed.  This may take a few minutes. 

 
e. Press Enter to close the installation windows  
 
f. Press any key to return to the Ex Libris Automation Tool menu. 
 
g. Press Q, then Enter to Quit the Automation Tool. 
 

Oracle 10g ODBC is now successfully installed  
on Windows Vista!  

 
 
Installing Oracle 10g for Windows 7 ONLY 
(for Vista, see page 5) 
 

1. Restart your computer  
 
2. Log on to the PC as an Administrator and ensure that there are no open programs.  
 
3. For the Microsoft Windows 7 environment only, run the BEAT tool as Administrator from the command 

line as follows:  
a Click Start > All Programs > Accessories > Command Prompt.  
 
b Right click on Command Prompt.  
 
c Click Run as administrator. If you receive a “User Account Control” warning, click Yes to proceed. 

The command line window opens.  
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d Change the directory (cd) to the location of the unzipped files, specifically, the location of the BEAT-
win7.bat file: C:\Oracle10g\10203_client_vista-win7\ : 

Type cd \Oracle10g\10203_client_vista-win7 

 
 
e Run BEAT-win7.bat from the command line: 

Type BEAT-win7.bat 

 
 
4. When the “Brian’s ExLibris Automation Tools (BEAT) menu opens, select option 3, Install Oracle 10i 

Client.  (This is a typo in the program; it will actually install Oracle 10g.) 
 
5. When it asks “Are you sure you want to install?” Type Y to proceed.  Some text will scroll by in the 

command line window, then the Oracle Universal Installer Welcome screen displays. 
 If the Oracle Universal Installer Welcome screen does not appear, but the BEAT program prompts to 

Press any key to continue, you will need to restart the installation. Verify the conditions from “Before you 
begin” above. 

 

 
6. Click Next. The Available Product Components screen displays. 



CARLI   REV 7/5/2016 

Confidential and proprietary information of Ex Libris Group, Inc. Copyright © 2007. Ex Libris Group, Inc. All rights reserved. CARLI has 
added important information local to CARLI’s Voyager environment and necessary for connecting to CARLI servers.                Page 8 of 32 

 
7. Click the check box for “Show all components, including required dependencies. 
 
8. Click the box next to Oracle Windows Interfaces. Make sure that Oracle ODBC Driver is checked. 
 

 
 
9. Scroll down the list and check the box for Oracle Net. 
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10. Click Next.  

 

 
11. The Product‐ Specific Prerequisite Checks screen displays.  The operating system version check fails and 
display the Status “Error”. This is okay.  Select the check box to the right of the highlighted error message and 
click Next to continue with the installation. 

 
 

 
12. Click Yes to proceed when you receive the warning message. 
 

 
13. On the Summary screen, Click Install. The installation takes a few minutes. A patch is also installed on a 
new screen. When installation has completed, the Oracle Net Configuration Assistant: Welcome screen 
displays. 
 
If the Oracle Net Configuration Assistant does not display: Some libraries have reported that not all of the 
necessary Oracle components are installed during the automatic installation process. In order to get all the 
needed components, go back and repeat Section III for Windows 7 installations, but manually put a check mark 
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by all of the components in the list in step 6 before clicking Next and moving on to step 7; do not just rely on the 
check mark next to "Oracle Client 10.2.0.3.0" at the top to mean everything in the hierarchy underneath it will be 
installed. 
 
 

 
14. Select the Perform typical configuration check box and click Next. Another Welcome screen displays. 
 

 
15. Click Next on the second Welcome screen. 
 
16. Click Finish when the Oracle Net Configuration Complete screen displays.  
 
17. Click Exit when the End of Installation screen displays.  
 
18. Click Yes when prompted with the exit warning. 
 
19. In the command line box, press any key to continue. 
 
20. Choose q to quit 
 
21. Type exit at the command line prompt to close the command line program. 
 

Oracle 10g ODBC is now successfully installed on Windows 7!  
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IV. Oracle/ODBC Configuration  
 
Before You Start  
 
These instructions cover a NEW installation of Oracle 10g.  If your task is a migration from Oracle 9i clients to 
Oracle 10g clients on the PC you should stop and use a different set of instructions called “Migrating from 
Oracle 9i to Oracle 10g Clients: Oracle/ODBC Installation Guide” to configure Oracle/ODBC on the PC. 
 
These instructions are for configuring a PC to run queries/reports against a copy of your library’s production 
databases on the I-Share Reports server (or to use the Gary Strawn Cataloging Utilities).  Reports and queries 
can also be run against the Training databases; for configuration instructions to Training databases, see the 
document “Reporting Against the Voyager Training Databases” at http://www.carli.illinois.edu/products-
services/i-share/execute#10g . 
 
New Installation Instructions  
 

1. Restart your computer  
 

a. Login to the PC as an Administrator. 
 
b. Ensure there are no open programs. Temporarily disable any PC firewall or virus software. 
 

2. Install the sqlnet.ora file that you downloaded from the CARLI website to your PC.   
 
a. Locate the sqlnet.ora file that you downloaded from the CARLI website to your PC back in 

section II. 
 
b. Navigate to the new oracle installation on the PC and open the 

C:\Oracle\product\10.2.0\client\NETWORK\ADMIN\ directory. 
 
c. Copy and paste the sqlnet.ora file that you downloaded from the CARLI website into the 

C:\Oracle\product\10.2.0\client\NETWORK\ADMIN\ directory to replace the existing file of the 
same name. 

 
d. When prompted to replace the existing file, say Yes. 
 

3. Open the Oracle Net Manager  
Start → Programs → Oracle-OraClient10g_home → Configuration and Migration Tools → Net 
Manager   
(this program may take a few seconds to open). 

 
4. Expand the Local “folder” by clicking on the plus sign to the left.  Then expand the Service Naming 

“folder” by clicking on the plus sign. 

http://www.carli.illinois.edu/products-services/i-share/execute#10g
http://www.carli.illinois.edu/products-services/i-share/execute#10g
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5. With the Service Naming folder highlighted, go to Edit → Create. 

 
 

6. In the Net Service Name Wizard, page 1 of 5: Net Service Name screen that opens, enter VGER for the 
Net Service Name and then click Next. 

 
 
 

7. On the Net Service Name Wizard, page 2 of 5: Protocol screen choose TCP/IP (Internet Protocol) and 
click Next. 

 
8. On the Net Service Name Wizard, page 3 or 5: Protocol Settings screen enter 

reports.carli.illinois.edu for the Host Name and keep the default Port Number of 1521.   
 
Then click Next. 
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9. On the Net Service Name Wizard, page 4 of 5 Service screen, choose (Oracle8 or Previous) SID 
and enter your library’s three-letter I-Share code in uppercase letters.  For example: SXU or RSH   
See Appendix A for your library’s three-letter code. 

 

 
 
Keep the default Connection Type of “Database Default”.  Then click Next. 

 
 

10. At the Net Service Name Wizard, page 5 of 5 Test screen, click Test. 
 
11. A database test will begin immediately using the default "scott/tiger" username and password. You will 

see a message “invalid username or password”. 

 
 
12. Click the Change Login button.  

                                          Enter your I-Share code here  
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Enter your Oracle username and password (this is not your Voyager operator ID), and click OK.   

 
 

13. Click Test in the Connection Test box. 
 

If you are using the correct username and password, then you should see the message “The 
connection test was successful.”   
 
If the test was unsuccessful, try the test again, making sure the Oracle username and password 
were entered correctly.  Also, please review the settings listed above.   
 
Please Note: If you receive the error “error writing entry to local tnsnames.ora file” with 64-bit 
Windows 7, please see #2 under “Known Issues” at http://www.carli.illinois.edu/products-services/i-
share/execute/secure/vgerwin7#oracle 
 
If the test continues to be unsuccessful, click Close and Cancel at the Test Service screen and 
contact the CARLI Office for assistance.  A failed test indicates a problem with your network 
configuration, your Oracle installation, or your PC configuration. 

 
14. If the test was successful, close the Connection Test window by clicking Close, then click Finish to 

complete the Net Service Name Wizard. 
 

15. Go to File → Save Network Configuration to save, and then exit the NetManager by going to File → 
Exit 
 

16. Open the ODBC Data Source Administrator in  
Start → Control Panel → Administrative Tools → Data Sources (ODBC)  
 
Please Note: If you are using 64-bit Windows 7, you cannot access the ODBC Data Source 
Administrator as stated above. Please see #3 under “Known Issues” at 
http://www.carli.illinois.edu/products-services/i-share/execute/secure/vgerwin7#oracle for instructions on 
how access the 32-bit ODBC Data Source Administrator before completing the rest of this section. 
 

17. Open the System DSN tab (the 2nd tab) 
 

18. Click Add to create a new Name.  Choose the “Microsoft ODBC for Oracle” driver type and click 
Finish.  

http://www.carli.illinois.edu/products-services/i-share/execute/secure/vgerwin7#oracle
http://www.carli.illinois.edu/products-services/i-share/execute/secure/vgerwin7#oracle
http://www.carli.illinois.edu/products-services/i-share/execute/secure/vgerwin7#oracle
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19. In the Microsoft ODBC for Oracle Setup box that appears, enter these values: 

 
[Data Source Name] eisreport  
[Description] Voyager Production Reporting 
[User Name] <your Oracle username> 
[Server] VGER 

 
and Click OK to close the Setup box.  The System Data Source has now been added.   

 
20. Next, test the ODBC connection by creating a File DSN entry. 

a. Open the File DSN tab (the 3rd tab). 
 
b. Click Add. 
 
c. Select type Microsoft ODBC for Oracle and click Next. 
 
d. Name this New Data Source vger 
 
e. Click Next. 
 
f. Click Finish. 
 
g. In the Microsoft ODBC for Oracle Connect box that appears enter these values: 

 
[User Name] <your Oracle username> 
[Password] <your Oracle password> 
[Server] VGER 
and Click OK. 

 
h. If the box disappears and you find yourself back at the third tab, the test was successful. If you 

receive an error message, please check the values you entered and try again. Also, check the 
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values created in the System DSN created above and try again. If the error message persists, 
contact the CARLI Office for assistance.  

 
i. If all was successful, delete the File DSN you just created by highlighting the name VGER and 

clicking Remove.   Answer Yes when asked if you are sure you want to remove the data source. 
 

21. Exit the ODBC Data Source Administrator by clicking OK. 
 

Oracle 10g ODBC is now successfully configured!  
 

Known Issues for 64-bit Windows and Office 
 
Error Writing Entry to Local tnsnames.ora file 
 

Some libraries have reported that they are unable to save new Service Names in the Net Manager 
program in Section IV, steps 14-15 due to the error “error writing entry to local tnsnames.ora file.”  This 
seems to be some kind of permissions issue with the Net Manager program or with the tnsnames.ora 
file that the Net Manager is editing during this process.   
 
Instead of using the Net Manager program, the best workaround is to copy the tnsnames.ora file from 
another PC (it need not be a Windows 7 PC) that already has Oracle 10g/ODBC installed and working 
to the new PC.  The tnsnames.ora file can be found in: 
C:\oracle\product\10.2.0\client\NETWORK\ADMIN\ 

 
Unable to locate either Microsoft ODBC for Oracle or eisreport DSN on 64-bit Windows 
 

You must use the 32-bit ODBC drivers in order to find the "Microsoft ODBC for Oracle" driver needed 
during configuration of your ODBC connection in Section IV, steps 16-21 of the CARLI I-Share Oracle 
10g/ODBC New Installation Guide. The 32-bit version of the Microsoft ODBC Administrator can usually 
be found at C:\Windows\SysWOW64\odbcad32.exe. 
 
To access the 32-bit drivers perform the following in place of step 16. 
 
16a. Open the Windows file explorer and navigate to the C:\Windows\SysWOW64 folder. Locate the 
odbcad32.exe file. Right-click it and select “Run as Admin”.   
 
Return to step 17 above and continue with the directions as normal. 
 

64-bit versions of Microsoft Office 
 

64-bit Microsoft Office installed on 64-bit Windows 7 will not work with Oracle/ODBC for reporting 
against Voyager. Ex Libris only supports an installation using Oracle 10g clients and 32-bit Microsoft 
Access. 
 
If your institution has the ability to support later versions of the Oracle ODBC clients, then you may be 
able to use 64-bit Access with Voyager. CARLI may not be able to provide troubleshooting on 
installation for this configuration. 
 

Microsoft Office 365 
 

At this writing, neither Ex Libris nor CARLI support the use of Microsoft Office 365 with ODBC or 
Voyager. 
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V. Link the .mdb File  
 
Before You Start  
If you already have an .mdb file that you have previously linked on another PC according to these instructions, 
you may be able to continue using that .mdb without any additional configuration.  If the .mdb file does not work, 
simply try relinking it according to the instructions below (omitting step 2 because you don’t need to make a new 
copy).   
 
A manual installation of the Voyager Reporter Client on your PC will have created this file:  \Voyager\Access 
Reports\Reports.mdb.  CARLI has also created a custom CARLI Reports mdb file with many useful features.  
The latest version of this file may be downloaded from the CARLI website at 
https://www.carli.illinois.edu/products-services/i-share/execute under the Oracle 10g Clients blind; or from 
https://www.carli.illinois.edu/products-services/i-share/reports, under the Running Access Reports in the I-Share 
Environment blind. Look for “Latest version of custom CARLI_Reports_20XX.mdb.” 
 
CARLI strongly recommends that you use the latest version of the CARLI Reports file in place of the generic 
Reports.mdb file. As of this writing the latest file is CARLI_reports_2016.mdb file, see  
http://www.carli.illinois.edu/products-services/i-share/reports/secure/CARLI-reports2016-info . 
The generic Reports.mdb file contains only the prepackaged reports supplied by Ex Libris. 
CARLI_reports_20XX.mdb files include the shared SQL and reports prepared by CARLI staff and I-Share 
library staff, along with those pre-packaged reports that I-Share libraries may find useful. 
 
These instructions are for configuring a PC to run queries/reports against a copy of your library’s production 
databases on the Reports server.  Reports and queries can also be run against the Training databases; for 
configuration instructions to Training databases, see the document “Reporting Against the Voyager Training 
Databases” at http://www.carli.illinois.edu/products-services/i-share/execute#10g . 
 
These instructions apply only to running 32-bit versions of Microsoft Access 2002 and later. The Oracle10g 
client may not function with 64-bit access. See “Known Issues for 64-bit Windows and Office” above for more 
details on supported software. 
 
Instructions for MS Access 2010 or later 

Linking instructions for MS Access 2007 begin on page 22 
Linking instructions for MS Access 2003 or earlier begin on page 27 
 
Note: Screenshots may depict both Access 2010 and 2013 

 
1. Set Macro Security Level  
 

a. Start MS Access  
 

b. Select the File tab 
 

c. Click Options 
 

d. Select the “Trust Center” in the left-hand pane. Select “Trust Center Settings…” 
 

e. Select “Macro Settings” in left-hand pane. Select the radio button next to “Enable all macros 
(not recommended; potentially dangerous code can run)” Click OK. Click OK again. 

 
f. You must Exit and restart MS Access  
 

2. Decide if you will use the default Reports.mdb file or the CARLI_reports_2016.mdb file (see Before 
You Start section above). 

https://www.carli.illinois.edu/products-services/i-share/execute
https://www.carli.illinois.edu/products-services/i-share/reports
http://www.carli.illinois.edu/products-services/i-share/reports/secure/CARLI-reports2016-info
http://www.carli.illinois.edu/products-services/i-share/execute#10g
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a. Navigate to the file on your PC 
 
b. Highlight the file and either Right-click or use the Edit menu to either make a copy of the file or to 

rename the file: eisreport.mdb 
 
c. Copying and/or Renaming this file will help you to know that this is the file you have linked up to 

the database, and may help to identify it after future upgrades. 
 
d. The remainder of these instructions will refer to this file as eisreport.mdb 

 
3. Open the eisreport.mdb file in MSAccess  

 
 

4. Prepare the file for linking 
a. Click on “External Data” tab 
 
b. Select “ODBC Database” 
 

 
 

 
c. The “Get External Data‐ODBC Database” screen pops up. Select “Link to the data source by 

creating a linked table.” Click OK. 
 



CARLI   REV 7/5/2016 

Confidential and proprietary information of Ex Libris Group, Inc. Copyright © 2007. Ex Libris Group, Inc. All rights reserved. CARLI has 
added important information local to CARLI’s Voyager environment and necessary for connecting to CARLI servers.                Page 19 of 32 

 
 

 
d. The “Select Data Source” screen pops up. Select “Machine Data Source” tab, choose 

“eisreport” and click OK. 
 

 
 
If you receive a security warning that says some content was disabled, choose to “Enable this 

content”. 
If you do not see eisreport listed as a Data Source Name, click Cancel. Verify whether you are using 

a 32-bit or 64-bit version of Access (Go to File, Account, About Access). 
 
e. The “Microsoft ODBC for Oracle Connect” screen pops up.  
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i. For User Name enter <your Oracle username>  
 

ii. For Password enter <your Oracle Password>  
 

iii. For Server enter VGER  
 

iv. Click OK.  
 

 
 

NOTE: It may take a few minutes before the next screen appears.  
 

f. The Link Tables screen will appear.  Click Deselect All.  

 
 
g. The box should briefly refresh and the Deselect All button will pop back up.  Then click OK. 
 

5. Build Database Links  
 

a. Click on the arrow at the end of the Navigation Bar 
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b. Select Forms 

  
 
 

c. Double-click Build database links to Voyager  

 
 

d. The Build links to Voyager box will appear.  Enter the following values: 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

ODBC Name eisreport 

Connect String VGER 

DB User ID  
(remove dbread) 

<your Oracle 
Username> 

Password  
(remove existing 
*s) 

<your Oracle 
Password> 

Tablespace*** XXXDB 

Relink checkbox Checked 
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***Where XXX represents your I-Share Voyager three-letter code in uppercase letters.  See Appendix A. 
 

Click Connect.  
 

i. If the connection is successful, the bottom window will list each table as it is 
successfully linked. The ALL_TAB_COLUMNS table will not link. This is not an error.  

 
ii. If you receive "error!" statements followed by "Process stopped too many errors!,” click 

Close and repeat steps 4-5 again, carefully checking the information being entered.  If 
you continue to receive error messages, contact the CARLI Office for assistance. 

 
iii. The linking will take anywhere from a few minutes to several hours, depending on your 

network connection. 
 

d. When the linking is complete (after linking through tables from A to Z), click Close in the “Build 
database links to Voyager” box. 

 

Prepackaged Reports are now successfully linked! 
You may now run queries and reports against the database. 

 
Instructions for MS Access 2007 

If you are using an earlier version of MS Access (2003 or earlier) please see linking 
instructions beginning on page 27 

 
1. Set Macro Security Level  
 

a. Start MS Access  

b. Select the Microsoft Office Button:   
 
c. Click Access Options 
 
d. Select the “Trust Center” in the left-hand pane. Select “Trust Center Settings…” 
 
e. Select “Macro Settings” in left-hand pane. Select the radio button next to “Enable all macros (not 

recommended; potentially dangerous code can run)” Click OK. Click OK again. 
  

f. You must Exit and restart MS Access  
 

2. Decide if you will use the default Reports.mdb file or the CARLI_reports_2016.mdb file (see Before 
You Start section above). 

 
a. Navigate to the file on your PC 
 
b. Highlight the file and either Right-click or use the Edit menu to either make a copy of the file or to 

rename the file: eisreport.mdb 
 
c. Copying and/or Renaming this file will help you to know that this is the file you have linked up to 

the database, and may help to identify it after future upgrades. 
 
d. The remainder of these instructions will refer to this file as eisreport.mdb 

 
3. Open the eisreport.mdb file in MSAccess  
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4. Prepare the file for linking 

a. Click on “External Data” tab 
 
b. Click on the “More” arrow in the “Import” section 
 
c. Select “ODBC Database” 
 

 
 

 
d. The “Get External Data‐ODBC Database” screen pops up. Select “Link to the data source by 

creating a linked table.” Click OK. 
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e. The “Select Data Source” screen pops up. Select “Machine Data Source” tab, choose 

“eisreport” and click OK. 
 

 
 
If you receive a security warning that says some content was disabled, choose to “Enable this 

content”. 
 
f. The “Microsoft ODBC for Oracle Connect” screen pops up.  

 
i. For User Name enter <your Oracle username>  

 
ii. For Password enter <your Oracle Password>  

 
iii. For Server enter VGER  

 
iv. Click OK.  

 

 
 

NOTE: It may take a few minutes before the next screen appears.  
 

g. The Link Tables screen will appear.  Click Deselect All.  
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h. The box should briefly refresh and the Deselect All button will pop back up.  Then click OK. 
 

5. Build Database Links  
 

e. Click on the arrow at the end of the Navigation Bar 

 
f. Select Forms 
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g. Double-click Build database links to Voyager  

 
 

h. The Build links to Voyager box will appear.  Enter the following values: 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
***Where XXX represents your I-Share Voyager three-letter code in uppercase letters.  See Appendix A. 

 
Click Connect.  

 
i. If the connection is successful, the bottom window will list each table as it is 

successfully linked. The ALL_TAB_COLUMNS table will not link. This is not an error.  
 
ii. If you receive "error!" statements followed by "Process stopped too many errors!,” click 

Close and repeat steps 4-5 again, carefully checking the information being entered.  If 
you continue to receive error messages, contact the CARLI Office for assistance. 

 
iii. The linking will take anywhere from a few minutes to several hours, depending on your 

network connection. 
 

d. When the linking is complete (after linking through tables from A to Z), click Close in the “Build 
database links to Voyager” box. 

 

Prepackaged Reports are now successfully linked! 
You may now run queries and reports against the database. 

 

ODBC Name eisreport 

Connect String VGER 

DB User ID  
(remove dbread) 

<your Oracle 
Username> 

Password  
(remove existing 
*s) 

<your Oracle 
Password> 

Tablespace*** XXXdb 

Relink checkbox Checked 
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Instructions for MS Access 2003 or earlier 

 
0. If you are using MS Access 2003 or later, complete this step zero.  Otherwise, proceed to step 1 

below.  
 

a. Start MS Access  
 
b. Select Tools  Macro  Security  Security Level tab 
 
c. Select the Low option  
 
d. Click OK  
 
e. You will receive a message indicating that “Unsafe expressions are blocked…Do you want to 

allow the evaluation of potentially unsafe expressions?”  Click Yes  
 
f. You must Exit and restart MS Access  
 

1. Decide if you will use the default Reports.mdb file or the CARLI_reports_2009.mdb file (see Before You 
Start section above). 

 
a. Navigate to the file on your PC 
 
b. Highlight the file and either Right-click or use the Edit menu to either make a copy of the file or to 

rename the file: eisreport.mdb 
 
c. Copying and/or Renaming this file will help you to know that this is the file you have linked up to 

the database, and may help to identify it after future upgrades. 
 
d. The remainder of these instructions will refer to this file as eisreport.mdb 

 
2. Open the eisreport.mdb file in MSAccess  

 
 

3. Prepare the file for linking 
 

a. Select File  Get External Data  Link Tables  

 
 

 
b. A Link box will appear  
 

i. Click the Files of Type drop down located at the bottom of the screen  
 

ii. Select ODBC Databases, usually located at the bottom of the list:  
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c. The Link screen will be replaced by the Select Data Source screen  
 

i. Select the Machine Data Source tab.  
 

ii. Select the Data Source Name eisreport  

 
iii. Click OK  
 

d. The Select Data Source window will be replaced by a Microsoft ODBC for Oracle Connect 
window.  

 
i. For User Name enter <your Oracle username>  
 
ii. For Password enter <your Oracle Password>  
 
iii. For Server enter VGER  
 
iv. Click OK.  
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NOTE: It may take a few minutes before the next screen appears.  
 

e. The Link Tables screen will appear.  Click Deselect All.  

 
 
f. The box should briefly refresh and the Deselect All button will pop back up.  Then click OK. 
 

4. Build Database Links  
 

a. Under Objects select the Forms option  

 
 

b. Double-click Build database links to Voyager  
 
c. The Build links to Voyager box will appear.  Enter the following values: 

 
ODBC Name eisreport 

Connect String VGER 

DB User ID  
(remove dbread) 

<your Oracle 
Username> 
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***Where XXX represents your I-Share Voyager three-letter code in uppercase letters.  See Appendix A. 
 

Click Connect.  
 

i. If the connection is successful, the bottom window will list each table as it is 
successfully linked. The ALL_TAB_COLUMNS table will not link. This is not an error.  

 
ii. If you receive "error!" statements followed by "Process stopped too many errors!,” click 

Close and repeat steps 4-11 again, carefully checking the information being entered.  If 
you continue to receive error messages, contact the CARLI Office for assistance. 

 
iii. The linking will take anywhere from a few minutes to several hours, depending on your 

network connection. 
 

d. When the linking is complete (after linking through tables from A to Z), click Close in the “Build 
database links to Voyager” box. 

 

Prepackaged Reports are now successfully linked! 
You may now run queries and reports against the database.

Password  
(remove existing 
*s) 

<your Oracle 
Password> 

Tablespace*** XXXdb 

Relink checkbox Checked 
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LIBRARY CODE  LIBRARY CODE 
Adler University ADL  Lincoln Land Community College LLC 
Augustana College AUG  MacMurray College MMC 
Aurora University ARU  McKendree University MCK 
Benedictine University BEN  Meadville Lombard Seminary MLS 
Black Hawk College BHC  Millikin University MIL 
Bradley University BRA  Monmouth College MON 
Carl Sandburg College CSC  Morton College MRT 
Catholic Theological Union CTU  National-Louis University NLU 
Chicago State University CSU  The Newberry Library NBY 
College of DuPage COD  North Central College NCC 
Columbia College COL  North Park University NPU 
Concordia University Chicago CON  Northeastern Illinois University NEI 
Danville Area Community College DAC  Northern Illinois University NIU 
DePaul University DPU  Northern Seminary NBT 
Dominican University DOM  Oakton Community College OAK 
Eastern Illinois University EIU  Olivet Nazarene University ONU 
Elmhurst College ELM  Parkland College PRK 
Eureka College ERK  Principia College PRC 
Governors State University GSU  Quincy University QCY 
Greenville College GRN  Richland Community College RCC 
Harper College WRH  Robert Morris University RMC 
Heartland Community College HRT  Roosevelt University ROU 
Illinois Central College ICC  Rush University RSH 
Illinois College ILC  Saint Francis Medical Ctr College of Nursing SFM 
Illinois Eastern Community Colleges IEC  Saint Xavier University SXU 
Illinois Institute of Technology IIT  Sauk Valley Community College SVC 
Illinois Math & Science Academy IMS  School of the Art Institute Chicago SAI 
Illinois State Library ISL  South Suburban College SSC 
Illinois State University ISU  Southeastern Illinois College SEI 
Illinois Valley Community College IVC  Southern Illinois University Carbondale SIC 
Illinois Wesleyan University IWU  Southern Illinois University Edwardsville SIE 
JKM Library JKM  Southern Illinois University School of Medicine SIM 
John Wood Community College JWC  Southwestern Illinois College SWI 
Joliet Junior College JOL  Trinity Christian College TRN 
Judson University JUD  Trinity International University TIU 
Kankakee Community College KCC  Triton College TRT 
Kishwaukee College KIS  University of Illinois at Chicago UIC 
Knox College KNX  University of Illinois at Springfield UIS 
Lake Forest College LFC  University of Illinois at Urbana-Champaign UIU 
Lewis & Clark Community College LAC  University of Saint Francis USF 
Lewis University LEW  University of St. Mary of the Lake SML 
Lincoln Christian College & Seminary LCC  Western Illinois University WIU 
Lincoln College LNC  Wheaton College WHE 
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